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Question: 1  
What are the requirements for creating data forms? (Choose five.) 
 
A. Member formulas 
B. Task lists 
C. Data form properties 
D. Access rights 
E. Row and column layout 
F. POV definitions 
G. Display options 
 
Answer: C, D, E, F, G 
 
Question: 2  
Which statement(s) is/are true about task list navigation? (Choose all that apply.) 
 
A. Basic mode provides you with a wizard to guide you through task list steps. 
B. Advanced mode enables you to work with task lists and Planning functions that you have 

access to simultaneously. 
C. (None of the above) 
 
Answer: A, B 
 
Question: 3  
Planning units consist of: (Choose three.) 
 
A. A version 
B. A scenario 
C. An entity 
D. A time period 
E. A currency 
 
Answer: A, B, C 
 
Question: 4  
In member selection, the ____________function retrieves members at ALL LEVELS BELOW a 
specified parent. 
 
A. Ancestors 
B. BottomOfHierarchy 
C. Children 
D. Descendants 
 
Answer: D 
 
Question: 5  
Which text function is NOT available for an Essbase data source? 
 
A. CellText 
B. Date 
C. MemberAlias 
D. MemberDescription 
 
Answer: D 
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Question: 6  
Which options are specified when creating Analytic Services data load rules? (Choose five.) 
 
A. File delimiters 
B. Associated outline 
C. Header information 
D. Column fields and replace text strings 
E. Interface table mappings 
F. Member names to column fields mappings 
 
Answer: A, B, C, D, F 
 
Question: 7  
When using the MemberName function in a row heading, which parameter does NOT support the 
Current keyword? <<MemberName("GridName", Row, "DimName")>> 
 
A. DimName 
B. GridName 
C. Row 
 
Answer: A 
 
Question: 8  
Which report objects can you save in the repository and reuse in multiple reports? (Choose 
three.) 
 
A. Text boxes 
B. Images 
C. Charts 
D. Report footers 
E. Data cells 
 
Answer: A, B, C 
 
Question: 9  
When defining the Dimension Layout of a grid, the report designer may move dimensions into all 
of the following areas except for: 
 
A. Cells 
B. Columns 
C. Pages 
D. Rows 
 
Answer: A 
 
Question: 10  
After assigning data access rights to data forms, task lists, and process management, you must: 
 
A. Run the CalcAll business rule 
B. Refresh the Analytic Services database 
C. Refresh Planning 
D. (None of the above) 
 
Answer: C 
 



Exam Name: Hyperion Planning 9.3 Administrator I & II 
Exam Type: Oracle   
Exam Code: 1Z0-272 Total Questions: 82 
 

Page 3 of 20   

 

Question: 11  
View the Exhibit.  
The report below was created using two columns, Actual and Budget. Functions were used to 
display the periods in the columns. February was selected as the current Point of View for the 
year. Which functions were used to define the Year dimension members? 
 

 
 
A. Range, Children 
B. Range, Property 
C. Range, RelativeMember 
D. Range, SystemMemberList 
 
Answer: C 
 
Question: 12  
View the Exhibit. 
Given the information above, what is the total number of cells per block in the database? 
 

 
 
A. 17000 
B. 18500 
C. 19000 
 
Answer: C 
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Question: 13  
Which data-entry tasks can you perform in Planning data forms? (Choose six.) 
 
A. Launch business rules to perform predefined calculations on data that you enter 
B. Spread data from summary to base periods automatically 
C. Export data to a spreadsheet 
D. Annotate planning units, accounts, or cells 
E. Adjust existing data and add supporting details 
F. Modify data in display-only cells 
G. Import data directly from a flat file 
H. Type data directly into cells on a data-entry form 
 
Answer: A, B, C, D, E, H 
 
Question: 14  
You assign access to dimension members with the following: 
 
A. ImportSecurity utility 
B. Form Management 
C. BPM Architect Dimension editor 
 
Answer: A 
 
Question: 15  
Which statement is true regarding row and column templates? 
 
A. Can modify cell text 
B. Can automatically save changes by saving the report 
C. Can use inherit formatting 
D. Can modify formulas 
 
Answer: C 
 
Question: 16  
Which Planning data form tasks can you perform with Smart View? (Choose six.) 
 
A. View form instructions 
B. Adjust data 
C. Manipulate data with ad hoc adjustments 
D. Enter supporting detail and cell text 
E. Launch business rules 
F. Modify data in display-only cells 
G. Lock and spread values to base periods 
 
Answer: A, B, C, D, E, G 
 
Question: 17  
How many user variables can you set up for each dimension? 
 
A. 0 (none) 
B. 3 
C. Unlimited 
 
Answer: C 



Exam Name: Hyperion Planning 9.3 Administrator I & II 
Exam Type: Oracle   
Exam Code: 1Z0-272 Total Questions: 82 
 

Page 5 of 20   

 

 
Question: 18  
A user sets up a Choices list for the Scenario dimension of the Profit database to limit his user 
Point of View selections to Actual and Budget. This limits the user's member selection to: 
 
A. All reports generated for any database connection 
B. All reports generated for the Profit database connection 
C. Only the currently selected grid that retrieves data from the Profit database connection 
D. Only the currently selected report that retrieves data from the Profit database connection 
 
Answer: B 
 
Question: 19  
Which process state signifies that a planning unit has been rejected? 
 
A. Approved 
B. Under Review 
C. First Pass 
D. Not Started 
E. Signed Off 
F. Not Signed Off 
 
Answer: F 
 
Question: 20  
When you are logged into a Microsoft Office application, you can import reports and snapshots 
from Workspace though what integration? 
 
A. Smart View 
B. Smart List 
C. Integration Manager 
 
Answer: A 
 
Question: 21  
Reports are designed in: 
 
A. Financial Reporting Designer 
B. Financial Reporting Studio 
C. Hyperion System 9 Workspace 
 
Answer: B 
 
Question: 22  
In an Analytic Services outline, a generation: (Choose all that apply.) 
 
A. Describes a member's location within an outline hierarchy. 
B. Does NOT have child members. 
C. Is counted from the top of the dimension down through its descendants. 
 
Answer: A, C 
 
Question: 23  
In BPM architect, you have which option(s) for managing inherited property values? (Choose all 
that apply.) 
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A. Clear property values for an individual member, so that it reverts to the value from its nearest 

ancestor. 
B. Lock property at the ancestor level so that the inherited value cannot be overridden by its 

descendants. 
C. (You cannot manage dimension property value inheritance in BPM Architect) 
 
Answer: A, B 
 
Question: 24  
View the Exhibit. 
The following example is a report that includes: 
 

 
 
A. Expansions 
B. Related Content 
C. Supporting detail 
D. (All of the above) 
 
Answer: A 
 
Question: 25  
To maintain vertical separation between report objects that change size, use__________ 
positioning. 
 
A. Bottom 
B. Center 
C. Relative 
D. Top 
 
Answer: C 
 
Question: 26  
What are the product components of Hyperion System 9 Planning? (Choose all that apply.) 
 
A. Hyperion System 9 Planning 
B. Hyperion System 9 Shared Services 
C. Hyperion System 9 BI+ Financial Reporting 
D. Hyperion System 9 Smart View 
E. Hyperion System 9 Business Rules 
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F. Hyperion System 9 Workspace 
G. Hyperion System 9 BI+ Analytic Administration Services 
H. Hyperion System 9 BI+ Analytic Services 
I. Hyperion System 9 Financial Management 
 
Answer: A, B, C, D, E, F 
 
Question: 27  
Which dimension stores exchange rates for multicurrency applications? 
 
A. HSP_Rates 
B. HSP_Currency 
C. HSP_Conversion 
 
Answer: A 
 
Question: 28  
To refer to rows 5 through 8 in a mathematical function, a report designer uses the reference: 
 
A. row[5:8] 
B. row[5;8] 
C. row[5-8] 
D. row[5...8] 
 
Answer: A 
 
Question: 29   
To insert a saved text object into the report footer, a report designer must first add the object to 
the report and then: 
 
A. Change the vertical position to Bottom 
B. Drag the text object into the footer area 
C. Right-click in the text object and select Footer 
D. Set the position to Relative 
 
Answer: B 
 
Question: 30  
What Planning utility can you use to export and import data forms? 
 
A. ImpExpUtil 
B. FormDefUtil 
C. FormLoadDefUtil 
 
Answer: B 
 
Question: 31  
You can use which formulas in business rules? (Choose four.) 
 
A. Pro Rata 
B. Units-Rates 
C. Variable 
D. Custom 
E. Dimension 
F. Conditional 
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Answer: A, B, C, D 
 
Question: 32  
To which application elements can you assign access rights? (Choose four.) 
 
A. Account, Entity, Period, Scenario, and Version dimensions 
B. Smart lists 
C. Account, Entity, Scenario, and Version dimensions 
D. User-defined dimension members, if the Apply Security dimension property is selected 
E. Data forms 
F. Task lists 
 
Answer: C, D, E, F 
 
Question: 33  
To create reports in Financial Reporting Studio, a user must have the ____________ role. 
 
A. Analyst 
B. Manager 
C. Report Designer 
D. Report Editor 
 
Answer: C 
 
Question: 34  
A Planning application can be associated with: 
 
A. Only one project 
B. Multiple projects 
C. (None of the above) 
 
Answer: A 
 
Question: 35  
Destination options for a batch include: (Choose two.) 
 
A. Export to Excel 
B. Export as PDF 
C. Save as Snapshot 
D. Save as Word Document 
 
Answer: B, C 
 
Question: 36  
Which types of tasks can you define in a task list? (Choose five.) 
 
A. Workflow 
B. Menu item 
C. Descriptive 
D. URL 
E. Data form 
F. Business rule 
 
Answer: A, C, D, E, F 
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Question: 37  
Offline Planning enables you to: (Choose all that apply.)  
 
A. Work with Planning data forms in disconnect mode 
B. Use a local data source connection to work with Planning data forms in Excel 
C. Utilize the same robust features that Planning offers 
 
Answer: A, B 
 
Question: 38  
In BPM Architect Application Library, application views are validated before deploying them to 
ensure that: (Choose five.) 
 
A. The Start Year property is defined and contains 4 digits. 
B. Year dimension members start with FY, followed by a two-digit year. 
C. Start Month property is defined. 
D. Default Currency and Default Alias Table properties are defined. 
E. Account property is defined. 
F. The Start Year property and Year dimension describe the same year but in different formats. 
 
Answer: A, B, C, D, F 
 
Question: 39  
Planning uses which account types? (Choose six.) 
 
A. Expense 
B. Revenue 
C. Saved Assumption 
D. Liability 
E. Asset 
F. Equity 
G. Attribute 
H. Budget 
 
Answer: A, B, C, D, E, F 
 
Question: 40  
To automatically format cells based on specified attributes or values, use: 
 
A. Conditional formatting 
B. Format Painter 
C. Format option 
 
Answer: A 
 
Question: 41  
In Planning, what menu enables you to create, edit, move, delete, and assign access data forms? 
 
A. Edit menu 
B. File menu 
C. Administration menu 
D. Tools menu 
 
Answer: C 
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Question: 42  
Which mathematical functions are available in Financial Reporting? (Choose three.) 
 
A. Growth 
B. PercentOfTotal 
C. Rank 
D. Stdev 
E. Variance 
 
Answer: B, C, E 
 
Question: 43  
A report that contains static data from a specific point in time is a 
 
A. Report 
B. Saved Report Object 
C. Snapshot 
 
Answer: C 
 
Question: 44  
What time balance options can be used with Asset, Liability, and Equity account types? (Choose  
five.) 
 
A. Flow 
B. Balance 
C. First 
D. Average 
E. Weighted Average-Actual_Actual 
F. Weighted Average-Actual_365 
 
Answer: B, C, D, E, F 
 
Question: 45  
To retrieve a data value from a grid and place it in a text box, use the __________ text function. 
 
A. MemberProperty 
B. CellText 
C. DataSource 
D. GetCell 
 
Answer: D 
 
Question: 46  
The Current keyword is NOT supported in text functions entered in:  
 
A. Text boxes 
B. Text cells 
C. Row and column heading cells 
 
Answer: A 
 
Question: 47  
Which member selection is more efficient for generating reports? 
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A. Aggregate data segment in a row 
B. Single data segments in separate rows 
C. (Both are the same) 
 
Answer: A 
 
Question: 48  
Planning provides which tools for selecting tasks and documents? (Choose all that apply.) 
 
A. Planning menus 
B. Planning toolbar 
C. View pane 
D. Grid wizard 
 
Answer: A, B, C 
 
Question: 49  
Which of the following statements are true for entity members and plan types? (Choose all that 
apply.) 
 
A. When you create entity members, you assign plan types. 
B. If you do NOT assign a plan type to an entity, its children do NOT have access to that plan 

type. 
C. (None of these statements are true) 
 
Answer: A, B 
 
Question: 50  
You can use composite data forms to perform the following tasks: (Choose three.) 
 
A. Combine two or more forms on a single page. 
B. Perform real-time impact analysis by entering data in one data form and viewing the calculated 

results in another data form. 
C. Specify the order that data forms are displayed on a page and whether to combine the POV 

and page dimensions. 
D. Clone data forms. 
 
Answer: A, B, C 
 
Question: 51  
How many customizable plan types can you define in a Planning application? 
 
A. 2 
B. 3 
C. 5 
 
Answer: B 
 
Question: 52  
In Workspace, where do you set the current Planning application as the default application? 
 
A. View > Settings 
B. File > Preferences 
C. Administer > Settings 
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D. Edit > Properties 
 
Answer: B 
 
Question: 53  
Where do you provision Planning users and groups? 
 
A. User Management Console 
B. Dimension Editor 
C. User Authentication Manager 
D. Application Library 
 
Answer: A 
 
Question: 54  
In BPM Architect Application Library, which step(s) is/are required to deploy application views? 
(Choose all that apply.) 
 
A. Validate application views 
B. Compare application views 
C. Deploy application views to a Planning server 
D. Create application files only in relational databases 
 
Answer: A, B, C 
 
Question: 55  
In order to assign access to custom dimension members, you must apply security at what level? 
 
A. Dimension 
B. User 
C. Parent 
D. Type 
 
Answer: A 
 
Question: 56  
Which statements are true when creating folder structures for data forms? (Choose four.) 
 
A. You cannot rename, move, or delete the top-level folder called Forms 
B. You can assign access rights to folders 
C. You can move folders within the hierarchy 
D. You cannot assign access rights to folders 
E. You cannot delete a folder unless it is empty 
F. You can rename folders 
G. You can rename folders including the top-level folder named Forms 
 
Answer: C, E, F, G 
 
Question: 57  
View the Exhibit.  
The figure below displays lists for the Total Store Type dimension. What type of list is Gen2,Total 
Store Type? 
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A. System-defined list 
B. User-defined list 
C. Group list 
 
Answer: A 
 
Question: 58  
Which options appear in the Grid Properties sheet under the General category? (Choose two.) 
 
A. Row Headings Before 
B. Alias Table 
C. Hide Grid 
D. Position of Expansions 
E. Text Options 
 
Answer: A, B 
 
Question: 59  
What user role can access Financial Reporting studio, create report objects, and import and 
export Financial Reporting content? 
 
A. Scheduler 
B. Explorer 
C. Directory Manager 
D. Report designer 
 
Answer: D 
 
Question: 60  
SCENARIO: User A just entered information into a data form and is unable to launch a needed 
business rule. As the administrator, what must you do to solve this issue? 
 
A. Have User A launch the business rule from Analytic Administration Services 
B. Assign launch privileges to User A 
C. Have User A restart all running services 
D. (None of the above) 
 
Answer: B 
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Question: 61  
Which formulas are more efficient? 
 
A. Cell formulas 
B. Heading formulas 
C. Row and column formulas 
 
Answer: C 
 
Question: 62  
When the following report is generated, which scenario(s) will be displayed for Grid2? 
 
A. Actual 
B. Actual and Budget 
C. Budget 
 
Answer: C 
 
Question: 63  
Planning stores the application definition in: 
 
A. Shared Services 
B. Analytic Administration Services 
C. Relational Databases 
D. Planning Servers 
 
Answer: C 
 
Question: 64  
Review the following outlines of the Total Store Type and Total Product dimensions: 
The report below contains a link to another report. The linked report defines the columns and 
rows using the member selection Children of Current Point of View. f the user selects any of the 
three hyperlinks, what members will display in the COLUMNS of the linked report? 
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A. Total_Office and Total_Home 
B. Equipment, Furniture, and Stationery 
C. Lighting, Lumber, and Tools 
D. Total Product, Total_Office, and Total_Home 
 
Answer: A 
 
Question: 65  
When scheduling a batch, you can select _____ dimension(s) from the batch POV for bursting. 
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A. One 
B. Two 
C. Three 
 
Answer: A 
 
Question: 66  
There are _____ version dimension types for building your plan. 
 
A. 2 
B. 3 
C. 4 
 
Answer: A 
 
Question: 67  
You can load Planning data and metadata into the BPM Architect Dimension Library from: 
(Choose all that apply.) 
 
A. Interface tables 
B. Flat files 
C. Profiles 
 
Answer: A, B 
 
Question: 68  
The following report preview was generated from the report design below using an Average auto 
calculation. To set up the auto calculation for this report, the report designer must select the Auto 
Calculation check box for which grid area? 
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A. Qtr1, Qtr2 row heading 
B. Children of USReg row heading 
C. Row 2 
 
Answer: B 
 
Question: 69  
Which process state signifies that a planning unit is being reviewed by someone in the 
organization? 
 
A. Not Signed Off 
B. First Pass 
C. Signed Off 
D. Approved 
E. Not Started 
F. Under Review 
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Answer: F 
 
Question: 70  
Which types of charts can be designed in Financial Reporting Studio? (Choose three.) 
 
A. Bar 
B. Bubble 
C. Combo 
D. Line 
 
Answer: A, C, D 
 
Question: 71  
View the Exhibit. 
The following book table of contents collates the reports by: 
 

 
 
A. Book Point of View 
B. Member Selection 
C. Reports 
 
Answer: C 
 
Question: 72  
The order of dimensions is critical to the structure and performance of Analytic Services 
databases. How should dimensions be ordered to maximize performance? (Choose three.) 
 
A. Dense dimensions should be ordered most dense to least dense. 
B. Aggregating sparse dimensions should be ordered smallest to largest. 
C. Order does not affect non-aggregating dimensions. 
D. Non-aggregating sparse dimensions should be ordered smallest to largest. 
 
Answer: A, B, D 
 
Question: 73  
An IncStmt report is created in the Finance folder in the repository. To give Lturner access to the 
report, the report designer must assign View permission for Lturner on the: 
 
A. IncStmt report 
B. IncStmt report and Finance folder 
C. Incstmt report, Finance folder, and Root folder 
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Answer: B 
 
Question: 74  
A report designer can use an auto calculation to calculate the average of: 
 
A. Aggregate row 2 of a grid 
B. Rows 2 and 5 of a grid 
C. Rows from multiple grids 
 
Answer: A 
 
Question: 75  
In Planning, what mode enables you to access all menus, toolbars, and tasks assigned to you by 
your user role? 
 
A. Basic 
B. Advanced 
C. Administrator 
D. Shared 
 
Answer: B 
 
Question: 76  
In the Select Members dialog box, which of the following functions is NOT available from the Add 
Relationship button? 
 
A. Ancestors 
B. Current Point of View 
C. Siblings 
D. Parent (Inclusive) 
 
Answer: B 
 
Question: 77  
You can launch business rules from: (Choose four.) 
 
A. Shared Services 
B. Planning 
C. Business Rules Command Line Launcher 
D. Business Rules Web Launcher 
E. Analytic Administration Services 
 
Answer: B, C, D, E 
 
Question: 78  
Select the four types of access that you can assign to a task list: (Choose four.) 
 
A. None 
B. Manage and Assign 
C. Manage 
D. Assign 
E. Read only 
 
Answer: A, B, C, D 
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Question: 79  
Within each branch of a dimension, which values are calculated first for a Planning outline in 
Analytic Services? 
 
A. Level 0 values 
B. Level 1 values 
C. Parent value 
 
Answer: A 
 
Question: 80  
Which Financial Reporting tasks can you perform from Workspace? (Choose six.) 
 
A. Set preferences 
B. Perform administrative tasks such as managing users 
C. Create and modify books 
D. Change user POV members 
E. Assign access to repository items 
F. Create and schedule batches 
G. View and print reports and books 
 
Answer: A, B, C, E, F, G 
 
Question: 81  
You can use runtime prompts to enter variables in a business rule that are resolved when a user 
launches the rule. Which types of variables can you use in business rules? (Choose three.) 
 
A. Member or Members 
B. String, integer, real, or percent 
C. Task lists 
D. Dimension 
E. Menu item 
 
Answer: A, B, D 
 
Question: 82  
Which function is an auto calculation and a mathematical function? 
 
A. Average 
B. Difference 
C. Rank 
 
Answer: A 
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